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1 Introduction 

The Sun City Anthem Computer Club has added a class management feature to its new web site. As a 

student you can view the full class descriptions and register for classes from any computer using your 

favorite web browser. The system will even send reminders the day before your registered classes. As a 

teacher you can manage your class descriptions, dates, registrations and even cancel a session if the 

enrollment is too low. 

2 Basic Features 

2.1 Login 

The use of the on-line class management requires you to be a member of the Sun City Anthem Computer 

Club. You will use your Sun City Anthem Membership ID as your username to login to the web site (see 

figure 2-1). Alternatively, you can use your email address in place of your member ID. 

Figure 2-1: 

The first page you 
encounter is the 
login screen. Much 
of the site's content 
is shown only to 
authenticated 
users. 

 

After a successful login you will be presented with the main screen (see figure 2-2). Along the top you 

will find the Home and Contact Us quick links. The Home link will show this main page, so if you ever 

get lost within the site you can easily return to the main page. 

On the left side of the screen there are several blocks which provide access to the site content. The first 

block is called the Navigation block and provides links to other areas of interest. Among other things 

please note the My Account and Log Out entries. 

The second block is called the Upcoming Sessions block and displays information about upcoming 

classes, but more on that in section 2.3. 
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Figure 2-2: 

This is the main 
page after login. 
The first block is 
called the 
Navigation Block 
and contains a 
menu which acts as 
a road map to the 
entire site. 

 

2.2 Class Listing 

To view a listing of all the classes offered by the Club, select Classes from the Navigation block (see 

figure 2-3). The class title and a brief description is given for each class. The listing may span more than 

one page, so use the page controls after the list to select other pages. 

Figure 2-3: 

The class catalog is 
a listing of all 
classes offered by 
the Club. 

 

To view the full class description click on the class title. This will display a session listing for the class 

(see figure 2-4). 
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Figure 2-4: 

The sessions menu 
lists all the dates 
for a given class. 

 

From there, click on the View menu option (see figure 2-5). 

Figure 2-5: 

The View menu 
option displays the 
full description for 
the class. 

 

2.3 Enroll in a Class 

There are several methods you can use to enroll in a class. If you refer back to figure 2-3 you will notice 

a block located along the left edge of the screen called Upcoming Sessions. This block contains a list of 

the next five sequential classes and the class date. Clicking on the class title will bring you directly to the 

session enroll menu (see figure 2-6). 

Figure 2-6: 

The enroll menu lets 
you choose a role. 
Typically this would 
be Student. 
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The second method allows you to view the class sessions for any given month in a calendar format. To 

view this calendar, select either the More option in the Upcoming Sessions block or select the Calendar 

option in the Class Catalog (see figure 2.7). Clicking on the class title in the calendar will present the 

enroll menu. 

Figure 2-7: 

The calendar view 
shows the classes 
and dates for the 
month. 

 

Finally, you can click on the class title in the Class Catalog listing (figure 2-3) to display a list of 

sessions for the class (figure 2-4). At the end of each session line is the option to enroll. 

2.4 My Enrollment 

Now that you have enrolled in some classes, how do you remember which ones? Remember the main 

menu (figure 2-2)? In the Navigation block you will find a menu item called My Account. Clicking on 

this link will present you with information about your account. Now click on the Enrollment menu 

option to view your current enrollment (see figure 2-8). 
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Figure 2-8: 

The Enrollment 
option presents the 
list of your current 
enrollment. 

 

2.5 Drop Enrollment 

If you were observant, the enrollment listing (figure 2-8) has a check-box next to each class and a button 

after the listing called Drop. Simply click the check-box next to each class you wish to drop and then 

select the Drop button. You will be asked to confirm your action since this can not be reversed. If you 

change your mind (again) and want to enroll in the class, you will have to go through the enroll process 

once more. But be warned, if the class fills to capacity before you enroll again, you will be added to the 

waiting list. 

2.6 Reminders 

Would you like to receive an email reminder 24 hours prior to your enrolled class? From the My 

Account page, select the Notifications menu item to display notification options (see figure 2-9). 

Figure 2-9: 

Notification options 
allow you to 
manage your 
subscriptions. 

 

You can list your current subscriptions by clicking on the Subscriptions sub-menu option (see figure 2-

10). From here you have the ability to delete your subscriptions or temporarily suspend notifications. 
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Figure 2-10: 

List your current 
subscriptions from 
this sub-menu item. 

 

Finally, you can add reminder notifications in several ways, click either the User Enrollment link on the 

Overview menu (figure 2-9) or click the Add Subscription sub-menu option (figure 2-10). The user 

enrollment notifications are sent when you enroll or drop a session. Notification is also sent if the 

administrator changes or cancels the session. The Add Subscription menu allows you to have email 

sent immediately or in batches at a specified interval (see figure 2-11). 

Figure 2-11: 

Select your desired 
notification options. 
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3 Advanced Features 

3.1 Permissions 

Permission is the authority to perform certain actions within the site Permissions relevant to the Class 

Management system are as follows: 

Permission Description 

create class content The ability to create new class content 

edit any class content The ability to edit any class content 

edit own class content The ability to edit only one’s own class content 

delete any class content The ability to delete any class content 

delete own class content The ability to delete one’s own class content 

access class sessions The ability to view the class catalog and the session listing. 

enroll class sessions The ability to manage one’s own session enrollment. 

manage class sessions The ability to manage any session enrollment. 

administer class sessions The ability to add, delete, modify and clone any session. 

3.2 Roles 

A role is essentially a collection of permissions. Each user is assigned one or more roles. By default 

there are two roles: anonymous (a user who had not logged in) and authenticated (a user who has 

successfully logged in). The Class Management system added another role, namely Education Director. 

The authenticated role is assigned the following permissions: edit own class content, access class 

sessions, and enroll class sessions. This means that any Club Member can view the list of classes and 

manage their own enrollment. In addition, they can edit any class description they authored. 

The Education Director is assigned all of these permissions which grants anyone assigned to this role 

full authority over all class functions. 

There is a special case for inheriting the manage class sessions and administer class sessions 

permissions. The author of a class will inherit the administer class sessions permission for the purpose 

of adding a new session. Within a given session, both permissions are inherited by anyone enrolled in 

the staff role as explained in Section 3-5. 

3.3 Create a New Class 

To create a new class you first navigate to the home page. In the navigation block you should find a 

menu item called Create content. Clicking on this menu item will display the create content page 

where you will find an entry called Class (see figure 3-1). If either of these menu items is not visible, 

then you are not authorized to create class content because you are not assigned to the Education 

Director role. 
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Figure 3-1: 

Select Create 
content to define a 
new class. 

 

Selecting the Class menu item will bring you to the create class page (see figure 3-2). Here you enter 

the class title and description. The description or body can be manually split into two sections using the 

Split summary at cursor button. The first section should be a brief class description and will be 

displayed on the catalog page (see figure 2-3). The second section is the full class description. If you do 

not manually split the description, then the brief summary will be the first so many words as determined 

by site settings. 

The only other option you should consider changing is the Input format, which by default is a very 

limited subset of HTML. You may change this to full HTML if you know what you are doing. 

3.4 Edit an Existing Class 

You must either be the author of the class or belong to the Education Manager role in order to edit an 

existing class. Assuming you have the proper permission, navigate to view the current class description 

(see Section 2.2) and locate the Edit tab. The edit menu is identical to the add menu (figure 3-2). You 

may preview your changes using the Preview button and save your masterpiece using the Save button. If 

you know what you are doing and want to use full HTML in the description, click on the Input format 

option and choose Full HTML. 
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Figure 3-2: 

Fill in the Title and 
Body sections. 

 

3.5 Add a Session 

To add a new session for a class, you must first view the session listing as described in Section 2.2. If 

you have the proper permission the Add Session menu option should be visible as shown in figure 3-3. 

There are three steps to adding a new session, namely defining the enrollment period, the class dates and 

the roles available for enrollment. 

Figure 3-3: 

A new session 
requires some 
dates for the 
enrollment period. 
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The first step will define the registration dates. This is the time frame that a member can enroll in a 

class. Generally, the enrollment close date should be the same as the class start date and the enrollment 

open date would be 2 months prior to the close. Click on the Next button to proceed to the next step 

which will establish the class dates (see figure 3-4). 

Figure 3-4: 

Add session dates 
using the Add 
button. 

 

Notice that the default start date will be the enrollment close date. Change these date as appropriate for 

the class and click the Add button. A session may contain multiple start and end date pairs to 

accommodate a class spanning multiple dates. Click the Next button to proceed to the final step. 

Adding the session roles (see figure 3-5) determines how users enroll in the session. There are three 

defined roles; Student, Teacher and Class Aide. The site administrator defines the role names. If you 

need to edit the options for a role you added, simply delete the role and add it again. 

Figure 3-5: 

Add roles as 
needed to the 
session using the 
Add button. 

 

Let's examine each option in detail. The Capacity defines how many people can enroll for the specific 

role. Entering a value of zero means that the capacity is unlimited. Choose wisely. 

The Max Request entry defines the total number of seats that a single person can have for enrollment. 

Again, a value of zero implies an unlimited total enrollment per person. For our Club you should set this 

to one. 
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The Primary option determines the default enrollment role and there can be only one role so designated. 

This role is displayed first on the enroll menu (see figure 2-6). The Student role should have this option 

set. 

If you want to have a waiting list for a given role, then check the Wait List box. When the enrollment in 

a role reaches capacity, then subsequent enroll requests are placed on a waiting list. When an active 

enrollment is dropped, then requests on the waiting list are promoted to active enrollment on a first 

come, first served basis. This is all automatic and the process sends email to the appropriate people. 

Checking the Staff option enables anyone enrolled in the role to inherit the manage class sessions and 

administer class sessions permissions for this session only. The idea behind this option would be to 

allow teachers the capability to enroll or drop anyone on the roster as well as cancel the session. 

When a session is over or closed, the History option is used to add the enrollment to the history file. 

The choice to add the Class Aide role can be made by anyone enrolled in a role with the Staff 

permission since that role has the ability to manage all roles for the session. Having the Class Aide role 

defined does nothing more than allow someone to enroll in that role. Specifically, it does not send email 

advertising the need for teacher assistance. 

3.6 Manage Enrollment 

The ability to enroll or drop anyone's enrollment requires either the global Manage Class Sessions 

permission or the same permission inherited because of enrollment in a session's staff role. If you have 

the permission, then the various session menus will have additional options. 

The Enroll menu has the addition of the User to enroll field whereby person to enroll must be entered 

(see figure 3-6). There is a drop-down box with the options Userid and Last Name, First Name. If 

Userid is selected, then the data entry field expects you to enter a person's Membership ID. As you enter 

information in the data entry field, a momentary pause will cause a search of the Member database for 

reasonable matches. This lookup is very effective if the Last Name, First Name option is selected. Just 

enter a few characters of the last name and reasonable matches will be returned. 

Figure 3-6: 

The privileged user 
must enter either a 
Userid or the 
person's name. 

 

Likewise, the Roster menu (see figure 3-7) will have active check-boxes for everyone enrolled so that 

you can drop anyone from the class. 
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Figure 3-7: 

The authorized 
user can manage 
all enrollment. 

 

3.7 Cancel a Session 

With the proper permission, a session can be canceled by selecting the Cancel menu option. This action 

will delete the session and notify everyone enrolled. A confirmation menu is presented asking you to 

confirm this action since it can not be reversed. 

3.8 Close a Session  

The action of closing a session means that the session is complete and should be removed from the 

system. A confirmation menu is presented asking you to confirm this action since it can not be reversed. 

The enrollment for any roles marked with the History option will be recorded in the history file and then 

the session is removed. As always, the Close menu is available only if you have permission. 

It is important to close sessions soon after completion so that the enrollment history is updated and the 

session removed from the listings. To ensure this is done in a timely manner, the site will automatically 

close sessions 3 days after completion. 

3.9 Clone a Session 

Cloning a session gives you the ability to make an identical copy of an existing session with the 

exception of the enrollment and class dates. The Clone Session page (see figure 3-8) displays the class 

start date for the session you are cloning. You then enter the class start date for the new session. Let me 

emphasize that these dates are the class start dates and not the enrollment start dates. You can click in the 

New start date box to display a calendar popup to make selecting the new date easier. If you intend to 

change the class start times (notice I did not say dates), you will need to do that after the session is 

cloned. All session dates are adjusted according to the date difference between the old and new start 

dates. 

Please be aware that you must clone sessions at least one month in advance because completed sessions 

are automatically removed and are no longer available for cloning. 
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Figure 3-8: 

Create a new 
session using the 
settings from an 
existing session by 
cloning. 

 

You can optionally clone the enrollment of the session you are cloning by checking the appropriate 

boxes next to the role names. This is most useful for cloning the Teacher enrollment. Once you have 

made your selections and checked the box in front of the title, click on the Create Clone button. 

3.10 Clone Multiple Sessions 

To clone multiple sessions at once, you must have the Administer Class Sessions global permission. 

Inheriting this permission does not qualify. If you have the proper permission, the Class Listing page 

will contain the additional Clone Sessions menu option (see figure 3-9). 

Figure 3-9: 

The privileged user 
can clone multiple 
sessions at once. 

 

Cloning multiple sessions is almost identical to cloning a single session with a few minor exceptions. 

First, you must select a range a class start dates (see figure 3-10) and then click the View button. Now 

select each session you want to clone, enter the appropriate new start date, check any enrollment to be 

cloned and then click the Clone Sessions button. 

To clone sessions which are offered bi-monthly or quarterly, the process is identical except that the new 

date will more than one month from the start date. 

Once again, please be aware that you must clone sessions at least one month in advance because 

completed sessions are automatically removed and are no longer available for cloning. This is even more 

critical for bi-monthly or quarterly sessions. You have been warned. 
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Figure 3-10: 

Select each 
session to clone 
and enter the new 
session date. 
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4 Reports 

The session attendance report is available under the Club Management option in the Navigation menu 

on the Home page. Select Reports to view the report selection menu (see figure 4-1). 

Figure 4-1: 

Several reports are 
available under the 
Club Management 
menu. 

 

Selecting the Session Attendance report will result in a menu asking you to select a month for the 

report. After selecting the desired month, click the Generate Report button. The resulting report will be 

displayed as shown in figure 4-2. 

Figure 4-2: 

Sample session 
attendance report . 

 

 


